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Regulatory Compliance

Regulatory Compliance

The ADuCM3029 EZ-KIT is designed to be used solely in a laboratory environment. The board is not intended for
use as a consumer end product or as a portion of a consumer end product. The board is an open system design
which does not include a shielded enclosure and therefore may cause interference to other electrical devices in close
proximity. This board should not be used in or near any medical equipment or RF devices.
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The ADuCM3029 EZ-KIT contains ESD (electrostatic discharge) sensitive devices. Electrostatic charges readily accu-
mulate on the human body and equipment and can discharge without detection. Permanent damage may occur on
devices subjected to high-energy discharges. Proper ESD precautions are recommended to avoid performance degra-
dation or loss of functionality. Store unused boards in the protective shiping package.

ADuCM3029 EZ-KIT XXX EZ-KIT ® Manual ii



Contents

Preface

Purpose of This Manual................................................................................................................................. 1–1

Intended Audience......................................................................................................................................... 1–2

Manual Contents ........................................................................................................................................... 1–2

Technical Support .......................................................................................................................................... 1–2

Supported Processors ..................................................................................................................................... 1–3

Supported Tools............................................................................................................................................. 1–3

Product Information...................................................................................................................................... 1–3

Analog Devices Web Site ............................................................................................................................ 1–4

EngineerZone ............................................................................................................................................. 1–4

Notation Conventions ................................................................................................................................... 1–4

Using the Board

Product Overview .......................................................................................................................................... 2–1

Package Contents........................................................................................................................................... 2–2

Default Configuration ................................................................................................................................... 2–3

Using CCES and Board Installation............................................................................................................... 2–3

IAR Embedded WorkBench and Board Installation ....................................................................................... 2–3

IAR Embedded WorkBench Session Startup .................................................................................................. 2–4

Debug Interface ............................................................................................................................................. 2–5

Power-On-Self Test........................................................................................................................................ 2–5

Power Measurements ..................................................................................................................................... 2–5

Example Programs ......................................................................................................................................... 2–5

Reference Design Information ....................................................................................................................... 2–6

ADuCM3029 EZ-KIT XXX EZ-KIT ® Manual iii



32M-bit Serial Flash Memory with Dual and Quad SPI (W25Q32).............................................................. 2–6

16-Bit Digital I2C Temperature Sensor (ADT7420) ...................................................................................... 2–6

Micropower 3-Sensor Combination Including Acceleration and Temperature (ADXL363) ........................... 2–7

USB Uart IC (FT232R)................................................................................................................................. 2–7

ADF7xxx Interface......................................................................................................................................... 2–8

Arduino Interface........................................................................................................................................... 2–8

Expansion Interface 3 .................................................................................................................................... 2–9

Hardware Reference

System Architecture ....................................................................................................................................... 3–1

Switches......................................................................................................................................................... 3–2

Boot Mode Select (SW1) ............................................................................................................................ 3–2

Reset Push Button (SW2)........................................................................................................................... 3–3

Wake Push Button (SW3)........................................................................................................................... 3–3

GPIO Push Buttons (SW4-5)..................................................................................................................... 3–3

Jumpers ......................................................................................................................................................... 3–3

Main Power Select (JP1)............................................................................................................................. 3–4

IO Power Select (JP2)................................................................................................................................. 3–4

ADXL363 Power Enable (JP3) ................................................................................................................... 3–5

W25Q32 Power Enable (JP4)..................................................................................................................... 3–5

ADT7420 Power Enable (JP5) ................................................................................................................... 3–5

Current Measurement (JP6) ....................................................................................................................... 3–5

Remote Boot Select (JP8) ........................................................................................................................... 3–5

Remote Reset (JP9) .................................................................................................................................... 3–5

WAKE Select Jumper (JP10) ...................................................................................................................... 3–6

ADC VREF Select (JP11) ........................................................................................................................... 3–6

Battery Select (JP12) .................................................................................................................................. 3–6

LEDs ............................................................................................................................................................. 3–6

iv ADuCM3029 EZ-KIT XXX EZ-KIT ® Manual



Reset (LED1).............................................................................................................................................. 3–7

Power (LED2) ............................................................................................................................................ 3–7

GPIO (LED3–5) ........................................................................................................................................ 3–7

Connectors .................................................................................................................................................... 3–8

Expansion Interface 3 (P1A)....................................................................................................................... 3–8

ADF7xxx (P1 - P3, P9)............................................................................................................................... 3–9

Debug (P4 & P5) ....................................................................................................................................... 3–9

USB Connector (P6) .................................................................................................................................. 3–9

Power Connector (P8) ................................................................................................................................ 3–9

Battery (J1 & J5) ........................................................................................................................................ 3–9

PV Cell (J2)................................................................................................................................................ 3–9

Clock (J3 & J4) .......................................................................................................................................... 3–9

Arduino (J6 - J9) ........................................................................................................................................ 3–9

ADuCM302x GP I/O Multiplexing

ADuCM302x GP I/O Multiplexing

ADuCM3029 EZ-KIT XXX EZ-KIT ® Manual v



1   Preface

Thank you for purchasing the ADuCM3029 EZ-KIT ®, Analog Devices, Inc. evaluation system for the
ADuCM3029 processor.

The ADuCM3029 processor is based on the ARM® Cortex®-M3 processor core and is designed for motor control
and industrial applications. The EZ-KIT is shipped with all of the necessary hardware—you can start the evaluation
immediately. The package contains the standalone evaluation board, CE-approved power supply, and USB cable.
The EZ-KIT Lite version ships with the J-Link Lite ARM, while the EZ-KIT® version requires the customer to
provide an emulator.

The ADuCM3029 processor is based on the ARM® Cortex®-M4 processor core and is an ultra low-power inte-
grated mixed-signal microcontroller system for processing, control and connectivity. The MCU system is based on
an ARM® Cortex®-M3 processor, a collection of digital peripherals, embedded SRAM and flash memory, and an
analog subsystem which provides clocking, reset and power management capability in addition to an ADC subsys-
tem. The EZ-KIT is shipped with all of the necessary hardware—you can start the evaluation immediately. The
package contains the standalone evaluation board, J-Link Lite emulator, CE-approved power supply, and USB cable.

The EZ-KIT contains three main expansion interfaces. An Expansion Interface 3 (EI3) connector, three ADF7xxx
connectors and 4 Arduino connectors..

The evaluation board is designed to be used in conjunction with the IAR Embedded Workbench development tools
to test capabilities of the ADuCM3029 processor. The development environment aids advanced application code
development and debug, such as:

• Create, compile, assemble, and link application programs written in C++, C, and assembly

• Load, run, step, halt, and set breakpoints in application programs

• Read and write data and program memory Read and write core and peripheral registers

Purpose of This Manual
This manual provides instructions for installing the product hardware (board). The text describes operation and
configuration of the board components and provides guidelines for running code on the board.

Preface
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Intended Audience
The primary audience for this manual is a programmer who is familiar with an ARM Cortex-M3-based processor
core.

The ADuCM3029 family of mixed-signal control processors is based on the ARM Cortex-M3 processor core.

The applicable documentation for programming the ARM Cortex-M3 processor core includes:

• Cortex-M4 Devices Generic User Guide

• CoreSight ETM-M4 Technical Reference Manual

• Cortex-M3 Technical Reference Manual

For additional information on this Analog Devices processor, see the Hardware Reference Manual. This document
describes the processor core and memory architecture used on the ADuCM3029processor, but does not provide de-
tailed programming information for the ARM core.

For more information about programming the ARM core, visit the ARM Information Center:

http://infocenter.arm.com/help/.

Manual Contents
The manual consists of:

• Using the board

Provides basic board information.

• Hardware Reference

Provides information about the hardware aspects of the board.

• BOM

A companion file in PDF format that lists all of the components used on the board.

• Schematic

A companion file in PDF format documenting all of the circuits used on the board.

Technical Support
You can reach Analog Devices processors and DSP technical support in the following way

• Post your questions in the processors and DSP support community at EngineerZone®:

http://ez.analog.com/community/dsp

• Submit your questions to technical support directly at:

Intended Audience
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http://www.analog.com/support

• E-mail your questions about processors, DSPs, and tools development software from CrossCore Embedded Stu-
dio or VisualDSP++®:

If using CrossCore Embeded Studio or VisualDSP++ choose Help > Email Support. This creates an e-mail to
processor.tools.support@analog.com and automatically attaches your CrossCore Embedded Studio or Visu-
alDSP++ version information and license.dat file.

• E-mail your questions about processors and processor applications to:

processor.tools.support@analog.com

processor.china@analog.com

• Contact your Analog Devices sales office or authorized distributor. Locate one at:

http://www.analog.com/adi-sales

• Send questions by mail to:

Analog Devices, Inc.

Three Technology Way

P.O. Box 9106

Norwood, MA 02062-9106

USA

Supported Processors
This evaluation system supports the Analog Devices ADuCM3029 processor.

Supported Tools
Information on supported tools for the ADuCM3029 EZ-KIT and the ADuCM3029 family of processors is availa-
ble at:

http://www.analog.com/ADuCM3029EZKIT

Product Information
Product information can be obtained from the Analog Devices Website and the CCES online help.

Product information can be obtained from teh Analog Devices Website

Supported Processors
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Analog Devices Web Site

The Analog Devices Web site, http://www.analog.com, provides information about a broad range of products—ana-
log integrated circuits, amplifiers, converters, and digital signal processors.

To access a complete technical library for each processor family, go to http://www.analog.com/processors/techni-
cal_library. The manuals selection opens a list of current manuals related to the product as well as a link to the
previous revisions of the manuals. When locating your manual title, note a possible errata check mark next to the
title that leads to the current correction report against the manual.

Also note, MyAnalog.com is a free feature of the Analog Devices Web site that allows customization of a Web page
to display only the latest information about products you are interested in. You can choose to receive weekly e-mail
notifications containing updates to the Web pages that meet your interests, including documentation errata against
all manuals. MyAnalog.com provides access to books, application notes, data sheets, code examples, and more.

Visit MyAnalog.com to sign up. If you are a registered user, just log on. Your user name is your e-mail address.

EngineerZone

EngineerZone is a technical support forum from Analog Devices, Inc. It allows you direct access to ADI technical
support engineers. You can search FAQs and technical information to get quick answers to your embedded process-
ing and DSP design questions.

Use EngineerZone to connect with other DSP developers who face similar design challenges. You can also use this
open forum to share knowledge and collaborate with the ADI support team and your peers. Visit http://
ez.analog.com to sign up.

Notation Conventions
Text conventions used in this manual are identified and described as follows. Additional conventions, which apply
only to specific chapters, may appear throughout this document.

Example Description

File > Close Titles in bold style indicate the location of an item within the CrossCore Embed-
ded Studio IDE’s menu system (for example, the Close command appears on the
File menu).

{this | that} Alternative required items in syntax descriptions appear within curly brackets and
separated by vertical bars; read the example as this or that. One or the other is
required.

[this | that] Optional items in syntax descriptions appear within brackets and separated by
vertical bars; read the example as an optional this or that.

[this, …] Optional item lists in syntax descriptions appear within brackets delimited by
commas and terminated with an ellipsis; read the example as an optional comma-
separated list of this.

Product Information
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Example Description

.SECTION Commands, directives, keywords, and feature names are in text with letter
gothic font.

filename Non-keyword placeholders appear in text with letter gothic font and italic
style format.

NOTE:
 

NOTE: For correct operation, ..

A note provides supplementary information on a related topic. In the online ver-
sion of this book, the word NOTE: appears instead of this symbol.

CAUTION:
 

CAUTION: Incorrect device operation may result if ..

CAUTION: Device damage may result if ..

A caution identifies conditions or inappropriate usage of the product that could
lead to undesirable results or product damage. In the online version of this book,
the word CAUTION: appears instead of this symbol.

ATTENTION:
 

ATTENTION: Injury to device users may result if ..

A warning identifies conditions or inappropriate usage of the product that could
lead to conditions that are potentially hazardous for devices users. In the online
version of this book, the word ATTENTION: appears instead of this symbol.

Notation Conventions
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2   Using the Board

This chapter provides information on the major components and peripherals on the board along with instrustions
for installing and setting up the emualtion software.

Product Overview
The board features:

• Analog Devices ADuCM3029 processor

• 64-pin QFN package

• 26 MHz oscillator

• SPI Flash (SPI2) chip

• 32Mb

• Windbond W25Q32

• Accelerometer (SPI2)

• Analog Devices ADXL363

• Temp Sensor

• Analog Devices ADT7420

• Universal Asynchronous Receiver/Transmitter (UART0)

• FTDI FT232R USB to UART IC

• USB mini -B

• Debug (SWD/SWO) interface

• J-Link Lite ARM debugger

• SWD/SWO 20-pin 0.1” header for use with IAR emulators

• SWD/SWO 10-pin 0.05” header

• LEDs

Using the Board
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• Five LEDs: one power (green), one board reset (red), and three general-purpose (amber)

• Push buttons

• Five push buttons: one reset, one wake, boot and two IRQ/Flag

• EI3 Connector

• CLKOUT
• SPORT0

• SPI1

• UART0

• TWI0

• Timers

• GPIOs

• RESET
• GND/3.3V/5V output

• Arduino Connectors

• ADF7xxx Connectors

• External power supply

• CE compliant

• 5V @ 3.6 Amps

• Other features

• Jumpers for processor current measurement

Package Contents
Your ADuCM3029 EZ-KIT package contains the following items.

• ADuCM3029 EZ-KIT board

• Universal 5V DC power

• USB 2.0 Cable

• J-Link Lite Emulator

Contact the vendor where you purchased your EZ-KIT or contact Analog Devices, Inc. if any item is missing.

Package Contents
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Default Configuration
The ADuCM3029 EZ-KIT board is designed to run as a standalone unit.

The Default Hardware Setupfigure shows the default settings for jumper and switches and the location of the jump-
ers, switches, connectors, and LEDs. Confirm that your board is in the default configuration before using the board.

UPDATE IMAGE

Figure 2-1: Default Hardware Setup

Using CCES and Board Installation
THIS NEEDS UPDATING

This is a test

IAR Embedded WorkBench and Board Installation
For information about the IAR Embedded WorkBench® product and software download, go to:

http://www.iar.com/en/Products/IAR-Embedded-Workbench.

The ADuCM3029 EZ-KIT software, based on the IAR Embedded WorkBench, can be found at:

http://www.analog.com/ADuCM3029EZKIT

Default Configuration
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Follow these instructions to ensure correct operation of the product software and hardware.

1. Connect the EZ-KIT board to a personal computer (PC) running IAR Embedded WorkBench, using a J-
Link/J-Trace emulator:

a. Plug one side of the USB cable into the USB connector of the emulator. Plug the other side into a USB
port of the PC running IAR Embedded WorkBench.

b. Attach the emulator to the header connector, P1 or P2, on the EZ-Board board.

2. Attach the provided cord and appropriate plug to the 5V power adapter:

a. Plug the jack-end of the power adapter into the power connector P9 (labeled 5V) on the EZ-Board board.

b. Plug the other side of the power adapter into a power outlet. The power LED (labeled LEDx ) is lit green
when power is applied to the board.

IAR Embedded WorkBench Session Startup
It is assumed that the IAR Embedded WorkBench software is installed and running on your PC.

1. Navigate to the IAR Embedded WorkBench environment via the Start menu.

NOTE: IAR Embedded WorkBench is not connected to the target board.
 

2. Choose File > Open > Workspace to open a workspace for the project to download and debug.

3. Choose Project > Options.

The General Options, Target page appears.

4. In Processor variant, ensure Device is Analog Devices ADSP-CM41z-X_Y, where X is the SRAM size in KB
and Y is the internal flash size in KB of the part on the target board.

On the Analog Devices ADSP-CM419F EZ-Board, SRAM size is 384 KB, and internal flash size is 2048 KB.

5. Choose Debugger in the Category pane.

The Debugger, Setup options page appears.

a. In Driver, choose J-Link/J-Trace as the emulator to be used to debug the target board.

b. Click the Download tab. The Debugger, Download options page appears.

c. Ensure Use flash loader(s) is enabled. Note that other download settings are optional.

6. Choose Debugger > J-Link/J-Trace in the Category pane.

The emulator Setup options page appears.

a. On the Setup page,

• In Reset, select Connect during reset from the drop-down list.

IAR Embedded WorkBench Session Startup
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• In JTAG/SWD speed, select Auto.

• (Optional) In Clock setup, change the default values.

b. On the Connection page,

• In Communication, select USB and Device 0.

• In Interface, select JTAG or SWD.

7. Click OK to save the emulator settings.

8. Choose Project > Debug and Download to download the project and start debugging.

Debug Interface
The EZ-Board provides a JTAG/SWD/SWV connection via a connector (P1), which is a 0.1” header. A 4-bit trace
connection also is available via a connector (P2). See JTAG/SWD Connector (P1) and TRACE and
JTAG/SWD/SWV Connector (P2) for more information.

Power-On-Self Test
The Power-On-Self-Test Program (POST) tests all EZ-KIT peripherals and validates functionality as well as connec-
tivity to the processor. Once assembled, each EZ-KIT is fully tested for an extended period of time with POST. All
EZ-KITs boards are shipped with POST preloaded into flash memory. The POST is executed by resetting the board
and pressing the proper push button(s). The POST also can be used as a reference for a custom software design or
hardware troubleshooting.

Note that the source code for the POST program is included in the Board Support Package (BSP) along with the
readme.txt file that describes how the board is configured to run POST.

Power Measurements
Locations are provided for measuring the current draw from various power planes. Precision 0.05 ohm shunt resis-
tors are available on the VDD_EXT, VDD_INT, USB_VBUS, and 3.3V voltage domains. For current draw, the jumper
is removed, voltage across the resistor can be measured using an oscilloscope, and the value of the resistor can be
measured using a precision multi-meter. Once voltage and resistance are measured, the current can be calculated by
dividing the voltage by the resistance. For the highest accuracy, a differential probe should be used for measuring the
voltage across the resistor.

Example Programs
Example programs are provided with the ADuCM3029 EZ-KIT Board Support Package (BSP) to demonstrate vari-
ous capabilities of the product. The programs can be found in the ADuCM3029_EZ-KIT\examples folder. Refer
to a readme file provided with each example for more information.

Debug Interface
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Reference Design Information
A reference design info package is available for download on the Analog Devices Web site. The package provides
information on the design, layout, fabrication, and assembly of the EZ-Board.

The information can be found at:

http://www.analog.com/ADuCM3029EZKIT

32M-bit Serial Flash Memory with Dual and Quad SPI
(W25Q32)

The W25Q32BV (32M-bit) Serial Flash memory provides a storage solution for systems with limited space, pins
and power. The 25Q series offers flexibility and performance well beyond ordinary Serial Flash devices. They are
ideal for code shadowing to RAM, executing code directly from Dual/Quad SPI (XIP) and storing voice, text and
data. The device operates on a single 2.7V to 3.6V power supply with current consumption as low as 4mA active
and 1uA for power-down.

The W25Q32BV array is organized into 16,384 programmable pages of 256-bytes each. Up to 256 bytes can be
programmed at a time. Pages can be erased in a group of 16 (4KB sector erase), groups of 128 (32KB block erase),
groups of 256 (64KB block erase) or the entire chip (chip erase). The W25Q32BV has 1024 erasable sectors and 64
erase blocks respectively. The small 4KB sectors allow for greater flexibility in applications that require data and pa-
rameter storage.

The W25Q32BV supports the standard Serial Peripheral Interface (SPI), and a high performance Dual/Quad ouput
as well as Dual/Quad I/O SPI: Serial Clock, Chip Select, Serial Data I/O0 (DI), I/O1 (DO), I/O2 (WP), and I/O3
(/HOLD). SPI clock frequencies of up to 104MHz are supported allowing equivalent clock rates of 208MHz
(104MHz x 2) for Dual I/O and 320MHz (80MHz x 4) fro Quad I/O when using Fast Read Dual/Quad I/O in-
structions. These transfer rates can outperform standard Asynchronous 8 and 16-bit Parallel Flash memories. The
Continous Read Mode allows for efficient memory access with as few as 8-clocks of instruction-overhead to read a
24-bit address, allowing true XIP (execute in place) operation.

16-Bit Digital I2C Temperature Sensor (ADT7420)

The ADT7420 is a high accuracy digital temperature sensor offering breakthrough performance over a wide indus-
trial range, housed in a 4 mm × 4 mm LFCSP package. It contains an internal band gap reference, a temperature
sensor, and a 16-bit ADC to monitor and digitize the temperature to 0.0078°C resolution. The ADC resolution, by
default, is set to 13 bits (0.0625°C). The ADC resolution is a user programmable mode that can be changed
through the serial interface.

The ADT7420 is guaranteed to operate over supply voltages from 2.7 V to 5.5 V. Operating at 3.3 V, the average
supply current is typi-cally 210 μA. The ADT7420 has a shutdown mode that powers down the device and offers a

Reference Design Information
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shutdown current of typically 2.0 μA at 3.3 V. The ADT7420 is rated for operation over the −40°C to +150°C
temperature range.

Pin A0 and Pin A1 are available for address selection, giving the ADT7420 four possible I2C addresses. The CT pin
is an open-drain output that becomes active when the temperature exceeds a programmable critical temperature lim-
it. The INT pin is also an open-drain output that becomes active when the tempera-ture exceeds a programmable
limit. The INT pin and CT pin can operate in comparator and interrupt event modes.

Micropower 3-Sensor Combination Including Acceleration
and Temperature (ADXL363)

The ADXL363 is an ultralow power, three-sensor combination consisting of a 3-axis MEMS accelerometer, a tem-
perature sensor, and an on-board ADC input for synchronous conversion of an external signal. The entire system
consumes less than 2 μA at a 100 Hz output data rate and 270 nA when in motion triggered wake-up mode.

The ADXL363 communicates via a serial port interface (SPI) and always provides 12-bit output resolution for all
three sensors.

The ADXL363 accelerometer provides selectable measurement ranges of ±2 g, ±4 g, and ±8 g, with a resolution of 1
mg/LSB on the ±2 g range. Unlike accelerometers that use power duty cycling to achieve low power consumption,
the ADXL363 does not alias input signals by undersampling; it samples the full bandwidth of the sensor at all data
rates.

The ADXL363 temperature sensor operates with a scale factor of 0.065°C (typical). Acceleration and temperature
data can be stored in a 512-sample multimode FIFO buffer, allowing up to 13 sec of data to be stored.

In addition to the accelerometer and temperature sensor, the ADXL363 also provides access to an internal ADC for
synchronous conversion of an additional analog input.

The ADXL363 operates on a wide 1.6 V to 3.5 V supply range, and can interface, if necessary, to a host operating
on a separate, lower supply voltage.

USB Uart IC (FT232R)

The FT232R is a USB to serial UART interface with the following advanced features:

• Single chip USB to asynchronous serial data transfer interface.

• Entire USB protocol handled on the chip. No USB specific firmware programming required.

• Fully integrated 1024 bit EEPROM storing device descriptors and CBUS I/O configuration.

• Fully integrated USB termination resistors.

• Fully integrated clock generation with no external crystal required plus optional clock output selection enabling
a glue-less interface to external MCU or FPGA.

Micropower 3-Sensor Combination Including Acceleration and Temperature (ADXL363)
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• Data transfer rates from 300 baud to 3 Mbaud (RS422, RS485, RS232) at TTL levels.

• 128 byte receive buffer and 256 byte transmit buffer utilising buffer smoothing technology to allow for high
data throughput.

• FTDI’s royalty-free Virtual Com Port (VCP) and Direct (D2XX) drivers eliminate the requirement for USB
driver development in most cases.

• Transmit and receive LED drive signals.

• UART interface support for 7 or 8 data bits, 1 or 2 stop bits and odd / even / mark / space / no parity

• FIFO receives and transmits buffers for high data throughput.

• Device supplied pre-programmed with unique USB serial number.

• Supports bus powered, self-powered and high-power bus powered USB configurations.

• Integrated +3.3V level converter for USB I/O.

• Integrated level converter on UART and CBUS for interfacing to between +1.8V and +5V logic.

• True 5V/3.3V/2.8V/1.8V CMOS drive output and TTL input.

• Configurable I/O pin output drive strength.

• Integrated power-on-reset circuit.

• Fully integrated AVCC supply filtering - no external filtering required.

• UART signal inversion option.

• +3.3V (using external oscillator) to +5.25V (internal oscillator) Single Supply Operation.

• Low operating and USB suspend current.

• Low USB bandwidth consumption.

• UHCI/OHCI/EHCI host controller compatible.

• USB 2.0 Full Speed compatible.

ADF7xxx Interface

The ADF7xxx interface supports the ADF7023, ADF7024, ADF7242, ADF7030 and ADF7030-1 wireless trans-
ceivers. These are low power, high performance, integrated radio transceivers supporting a wide range of modulation
schemes and channel widths in the sub-GHz and 2.4GHz frequency ranges

Arduino Interface

Add text here

ADF7xxx Interface
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Expansion Interface 3

Add text here

Expansion Interface 3
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3   Hardware Reference

This chapter describes the hardware design of the ADuCM3029 EZ-KIT board.

System Architecture
This section describes the configuration on the board (see the Block Diagram figure).

UPDATE IMAGE

Figure 3-1: Block Diagram

This EZ-Board is designed to demonstrate the ADSP-CM419F processor’s capabilities. The ADSP-CM419F EZ-
Board has a 30 MHz input clock and runs at 240 MHZ internally.

Hardware Reference
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USB circuitry and a mini USB AB connector are provided for connecting to the EZ-Board as a host or a device. The
frequency for the USB circuit is generated internally to the processor.

User I/O to the processor is provided in the form of two user push buttons and four LEDs. The software-controlled
switches (SoftConfig) facilitate the switch multi-functionality by disconnecting the push buttons from their associat-
ed processor pins and reusing the pins elsewhere on the board. See the ADSP-CM419F EZ-Board Schematic for
more information.

Switches
This section describes operation of the switches. The switch locations are shown in the Switch Locations figure.

UPDATE IMAGE

Figure 3-2: Switch Locations

Boot Mode Select (SW1)

The pushbutton switch determines the boot mode of the processor. The Boot Mode Select Switch table shows the
available boot mode settings. By default, the processor boots from the internal flash memory.

Switches
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Table 3-1:    Boot Mode Select Switch

Position Processor Boot Mode

0 UART download mode

1 Flash boot. Boot from integrated flash memory.

Reset Push Button (SW2)

The reset pushbutton resets the ADuCM3029 processor. The reset signal is also connected to the expansion connec-
tors via the SYS_HWRST signal. Reset (LED1) is used to indicate when the board is in reset.

Wake Push Button (SW3)

The wake push button is connected to the processor’s WAKE signal based on the setting WAKE Select Jumper
(JP10)

GPIO Push Buttons (SW4-5)

The GPIO push buttons are connected to the processor’s signals P1_14/GPIO30/SPI0_RDY/TEST_DTD5 and
P2_06/GPIO38/ADC0_VIN3, respectively.

Jumpers
This section describes functionality of the configuration jumpers. The Jumper Locations figure shows the jumper
locations.

Switches
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UPDATE IMAGE

Figure 3-3: Jumper Locations

Main Power Select (JP1)

The main power select jumper selects whether the main power source for the board is provided from the emulator
interface, USB or wall transformer. Refer to the Main Power Select Jumper table. The default setting is to power the
board from the wall transformer.

Table 3-2:    Main Power Select Jumper

Position Power Source

1 & 3 Emulator 5V

3 & 4 USB 5V

3 & 5 Wall 5V

IO Power Select (JP2)

The IO power select jumper selects whether the IO power source for the board is provided from the on-board 3V
regualtor, coin battery or PV cell battery. Refer to the IO Power Select Jumper table. The default setting is to power
the IO from the on-board regualtor.

Jumpers
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Table 3-3:    IO Power Select Jumper

Position Power Source

1 & 3 on-board regualtor

3 & 4 coin battery

3 & 5 PV cell battery

ADXL363 Power Enable (JP3)

The ADXL363 power enable jumper allows for the part to be connected or disconnected from the IO power rail.
When the jumper is installed it is connected to power. When the jumper is removed power is disconnected from the
device. The device can be removed from the power rail to allow for more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

W25Q32 Power Enable (JP4)

The W25Q32 power enable jumper allows for the part to be connected or disconnected from the IO power rail.
When the jumper is installed it is connected to power. When the jumper is removed power is disconnected from the
device. The device can be removed from the power rail to allow for more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

ADT7420 Power Enable (JP5)

The ADT7420 power enable jumper allows for the part to be connected or disconnected from the IO power rail.
When the jumper is installed it is connected to power. When the jumper is removed power is disconnected from the
device. The device can be removed from the power rail to allow for more accurate current measurements of the IO
rail when the device is not needed. The default is for the jumper to be installed.

Current Measurement (JP6)

The current measurement jumper is used to measure the current draw of the processor and the 3V IO power rail.
The default is for both jumpers to be installed. In order to measure the current draw of the processor remove the
jumper from pins 1 & 3 and insert an ammeter in series. In order to measure the current draw on the 3V IO rail
remove the jumper from pins 2 & 4 and insert an ammeter in series.

Remote Boot Select (JP8)

The remote boot select jumper allows the SYS_BMODE0 to be controlled by the FT232 when the jumper is installed.
The default is for the jumper not to be installed.

Remote Reset (JP9)

The remote reset jumper allows the SYS_HWRST to be controlled by the FT232 when the jumper is installed. The
default is for the jumper not to be installed.

Jumpers
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WAKE Select Jumper (JP10)

This jumper is used to determine what WAKE signal from the processor is connected to the Wake Push Button
(SW3).

Table 3-4:    WAKE Jumpers

Setting Signal

1 & 2 SYS_WAKE0

3 & 4 SYS_WAKE1

5 & 6 SYS_WAKE2

7 & 8

ADC VREF Select (JP11)

The ADC VREF select jumper it used to connect the ADC voltage reference of the processor to either the ADR441
or ADR127. When the jumper is placed on pins 1 and 2 the reference is conencted to the ADR441 which is a
ultralow noise, LDO XFET voltage reference with current sink and source. When the jumper is placed on pins 2
and 3 the reference is connected to the ADR127 which is a precisoin micropower LDO voltage reference. By default
the jumper is connected to pins 2 & 3.

Battery Select (JP12)

The battery select jumper is used to choose between powering the board with a coin battery or a AA battery. When
the jumper is installed on pins 1 and 2 the coin cell battery is selected. When the jumper is installed on pins 2 and 3
the AA battery is selected. The default setting is the jumper only connected to pin 1 so neither battery is connected
by default.

LEDs
This section describes the on-board LEDs. The LED Locations figure shows the LED locations.

Jumpers
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UPDATE IMAGE

Figure 3-4: LED Locations

Reset (LED1)

When LED5 is ON (red), it indicates that the master reset of all the major ICs is active. The reset LED is controlled
by the Analog Devices ADM708 supervisory reset circuit. A master reset is asserted by pressing SW25 which acti-
vates LED5. For more information, see Reset Push Button (SW2).

Power (LED2)

When LED7 is ON (green), it indicates that power is being supplied to the board properly. For more information,
see Power Architecture.

GPIO (LED3–5)

Four LEDs are connected to the general-purpose I/O pins of the processor (see the GPIO LEDs table). The LEDs
are active high and are ON (amber) by writing a 1 to the correct processor signal.

Table 3-5:    GPIO LEDs

LED Reference Designator Processor Programmable Flag Pin

LED1 PE_07

LEDs
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Table 3-5:    GPIO LEDs (Continued)

LED Reference Designator Processor Programmable Flag Pin

LED2 PE_06

LED3 PE_05

LED4 PE_04

Connectors
This section describes connector functionality and provides information about mating connectors. The connector
locations are shown in the Connector Locations figure.

UPDATE IMAGE

Figure 3-5: Connector Locations

NOTE: Connectors on the back of the board are noted with dotted lines.
 

Expansion Interface 3 (P1A)

Connectors
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Part Description Manufacturer Part Number

180-pin high-speed socket SAMTEC QSH-090-F-D_A

Mating Connector

180-pin high-speed socket SAMTEC QTH-090-01-F-D-A

ADF7xxx (P1 - P3, P9)

Debug (P4 & P5)

The debug connectors provides a connection point for the emualtor to interface with the processor. There are two
debig conenctors on the board. The P4 conenctor is a 0.1” connector from SAMTEC (SHF-110-01-L-D-TH). The
P5 connector is a 0.05" connector. For more information, see Debug Interface.

USB Connector (P6)

Part Description Manufacturer Part Number

USB mini-B Hirose UX60SC-MB-5S8

Power Connector (P8)

The power connector provides power to the board when the jumper of Main Power Select (JP1) is placed on pins 3
and 5. 

Part Description Manufacturer Part Number

0.65 mm power jack CUI 045-0883R

Mating Connector

5.0VDC@3.6A power supplier GLOBETEK GS-1750(R)

Battery (J1 & J5)

This is the battery connectors.

PV Cell (J2)

PV connector

Clock (J3 & J4)

Arduino (J6 - J9)

Connectors
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These are the Arduino connectors

Connectors

3–10 ADuCM3029 EZ-KIT XXX EZ-KIT ® Manual



4   ADuCM302x GP I/O Multiplexing

The table identifies the pin functions that are multiplexed on the general-purpose I/O pins of the package

Table 4-1:     Signal Muxing Table Port 0

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P0_00 P0_00 SPI0_CLK SPT0_BCLK

P0_01 P0_01 SPI0_MOSI SPT0_BFS

P0_02 P0_02 SPI0_MISO SPT0_BD0

P0_03 P0_03 SPI0_CS0 SPT0_BCNV SPI2_RDY

P0_04 P0_04 I2C0_SCL

P0_05 P0_05 I2C0_SDA

P0_06 SWD0_CLK P0_06

P0_07 SWD0_DATA P0_07

P0_08 P0_08 BEEP0_TONE

P0_09 P0_09 BEEP0_TONE SPI2_CSn

P0_10 P0_10 UART0_TX

P0_11 P0_11 UART0_RX

P0_12 P0_12 SPT0_AD0

P0_13 P0_13

P0_14 P0_14 TMR0_OUT SPI1_RDY

P0_15 P0_15

Table 4-2:     Signal Muxing Table Port 1

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P1_00 P1_00

P1_01 SYS_BMODE0 P1_01

ADuCM302x GP I/O Multiplexing
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Table 4-2:     Signal Muxing Table Port 1 (Continued)

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P1_02 P1_02 SPI2_CLK

P1_03 P1_03 SPI2_MOSI

P1_04 P1_04 SPI2_MISO

P1_05 P1_05 SPI2_CSn

P1_06 P1_06 SPI1_CLK

P1_07 P1_07 SPI1_MOSI

P1_08 P1_08 SPI1_MISO

P1_09 P1_09 SPI1_CS0

P1_10 P1_10 SPI0_CS1 SPI1_CS3

P1_11 P1_11 TMR1_OUT

P1_12 P1_12

P1_13 P1_13

P1_14 P1_14 SPI0_RDY

P1_15 P1_15 SPT0_ACLK

Table 4-3:     Signal Muxing Table Port 2

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P2_00 P2_00 SPT0_AFS

P2_01 P2_01 TMR2_OUT

P2_02 P2_02 SPT0_ACNV SPI1_CS2

P2_03 P2_03

P2_04 P2_04

P2_05 P2_05

P2_06 P2_06

P2_07 P2_07 SPI2_CSn

P2_08 P2_08 SPI0_CS2

P2_09 P2_09 SPI0_CS3

P2_10 P2_10 SPI2_CSn

P2_11 P2_11 SPI1_CS1

ADuCM302x GP I/O Multiplexing
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ADuCM302x GP I/O Multiplexing
The table identifies the pin functions that are multiplexed on the general-purpose I/O pins of the package

Table 6-1:     Signal Muxing Table Port 0

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P0_00 P0_00 SPI0_CLK SPT0_BCLK

P0_01 P0_01 SPI0_MOSI SPT0_BFS

P0_02 P0_02 SPI0_MISO SPT0_BD0

P0_03 P0_03 SPI0_CS0 SPT0_BCNV SPI2_RDY

P0_04 P0_04 I2C0_SCL

P0_05 P0_05 I2C0_SDA

P0_06 SWD0_CLK P0_06

P0_07 SWD0_DATA P0_07

P0_08 P0_08 BEEP0_TONE

P0_09 P0_09 BEEP0_TONE SPI2_CSn

P0_10 P0_10 UART0_TX

P0_11 P0_11 UART0_RX

P0_12 P0_12 SPT0_AD0

P0_13 P0_13

P0_14 P0_14 TMR0_OUT SPI1_RDY

P0_15 P0_15

Table 6-2:     Signal Muxing Table Port 1

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P1_00 P1_00

P1_01 SYS_BMODE0 P1_01

P1_02 P1_02 SPI2_CLK

P1_03 P1_03 SPI2_MOSI

P1_04 P1_04 SPI2_MISO

P1_05 P1_05 SPI2_CSn

P1_06 P1_06 SPI1_CLK

P1_07 P1_07 SPI1_MOSI

P1_08 P1_08 SPI1_MISO
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Table 6-2:     Signal Muxing Table Port 1 (Continued)

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P1_09 P1_09 SPI1_CS0

P1_10 P1_10 SPI0_CS1 SPI1_CS3

P1_11 P1_11 TMR1_OUT

P1_12 P1_12

P1_13 P1_13

P1_14 P1_14 SPI0_RDY

P1_15 P1_15 SPT0_ACLK

Table 6-3:     Signal Muxing Table Port 2

Signal Name Multiplexed
Function 0

Multiplexed
Function 1

Multiplexed
Function 2

Multiplexed
Function 3

P2_00 P2_00 SPT0_AFS

P2_01 P2_01 TMR2_OUT

P2_02 P2_02 SPT0_ACNV SPI1_CS2

P2_03 P2_03

P2_04 P2_04

P2_05 P2_05

P2_06 P2_06

P2_07 P2_07 SPI2_CSn

P2_08 P2_08 SPI0_CS2

P2_09 P2_09 SPI0_CS3

P2_10 P2_10 SPI2_CSn

P2_11 P2_11 SPI1_CS1
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